DocType Shortcut Function

Increase Routing Width; Switch to the next signal

PCB + layer

PCB * Cycle switch to the next signal layer

PCB Delete rDoeJEt:'gselected object; Undo the track when

PCB ALT-- Decrease Snap Size

PCB ALT++ Increase Snap Size

PCB CTRL+R Depend on reference point for copy object
repeatly

PCB CTRL+L Open layer manager

PCB CTRL+Q Hide/show network text

PCB SHIFT+M Remove All Copper Area fill data

PCB SHIFT+B Rebuild All Copper Area

PCB SHIFT+D Move Object(s) by reference point

PCB SHIFT+G Display track length while routing

PCB SHIFT+W Show favorite track width while routing

PCB SHIFT+R Change routing conflict

PCB SHIFT+S Toggle layers which is not active

PCB SHIFT+Double Click Delete selected track segment

PCB CTRL+SHIET+V :’:ts“tseci:i/eecrt(s) and keep the prefix, and hide the

PCB CTRL+SHIFT+SPACE Change routing angle, same as hotkey L

PCB CTRL+ALT+L Enable all layers

Footprint CTRL+SHIFT+ALT+D Open custom data dialog

Basic Skills

To use EasyEDA you need to be familiar with a few basic terms and concepts. The best way to
learn them is to open up EasyEDA, and create a new schematic:

File > New > Schematic, and play!

Saving Your Work Locally



Although EasyEDA saves all your files on our Server, sometimes you may want to save your
work locally and EasyEDA does provides a way to do this.

You can right-click your project folder, and click "Download Project", or export your design as
EasyEDA source file via "File > EasyEDA Source".

For more detail you look here: Export EasyEDA Source section.

To download your project:
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History Record

It is easy to use this function, right click on the document for which you need the history as in
the image below:
After clicking on the history link, you will get a list of the History as in the image below.
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Click the History number to open the saved file in the editor, if this is what you need, you can
save it to your project and delete your bad file.



Note:

1. For now, all the History entries are tagged with a number. An upcoming feature will allow
you to add a custom tag.

2. Saving your files too frequently will create many History entries and it will become more
difficult to find the exact one you want.

Document Recovery

No operating system, software or network is perfect, so sometimes things go wrong. Having
your Desktop or web browser freeze or your broadband connection drop, two hours into
laying out a PCB, could spoil your day.

However, with EasyEDA, your day will be just fine.

This is because EasyEDA auto saves and makes backups of all your open files to your
computer, crash recovery is built into EasyEDA.

On the top menu, click Menu - Advanced - Document Recovery as below:

te Tools Fabrication Advanced Setting Help Extension Name ~

Historical Records. ..

1000 1500 3000 3500 4000

& Backup Project
o< Share

Extensions

Document Recovery

All Projects v

] Free Documents

(1555 Timer - Flashing Lights copy
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(1555 Timer - LED Flash
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Expand the folder to the latest version, Select the file which you would like to recover, then
click the Recover button; your file will be opened in a new tab, then save this opened file.

Please note:

o fasyEDA saves these crash recovery files on your computer and not on the EasyEDA
server. Therefore you cannot recover files from a crash on one computer or browser by
changing to a different computer or browser.

o /fyou cleaned your browser's cache, the recovery files will disappear.



e /fyou made a mistake deleting a file and removing the cache, you might be able to find

your document in the recycle bin: https.//easyeda.com/account/user/recycles/personal.

Resizing the canvas area

Hovering the mouse cursor over the areas indicated by the three green ellipses will bring up
the blue sidebar toggle lines. Clicking on them will toggle the visibility of their associated right
and left areas to expand the canvas area. The vertical lines can be dragged horizontally to
resize the panels.

Mouse-Y 3020.000mil
Mouse-Dx 200.000mi
Mouse-D -40.000mil

~

—

Cursor Style

Some users do not like the cross cursor, so you can change it to an arrow cursor like in the
image below.

Via: Top Menu - View - Cross Cursor
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The difference between these options is shown below:



No Cross Cursor | With Cross Cursor |

Clear and delete
If you think your schematic or PCB looks terrible, and you want to redraw everything, you can
do this:

e Top Menu > Edit > Global Delete.

EDA File Edit Place Format View Design Route Tools Fabric

Und Ctri+Z
zned Projects = Yndo ;

0 Sheet_1 copy
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ra

FEB copy ¥ cut Ciri+X
]ﬂ[ Delete Delete
# Drag
Find... Ctri+F
Find Similar Objects... Ctri+Shift+F
Measure M

Clear All
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e Delete this schematic and create a new one.
e Click one object or CTRL+A, press delete key to remove all objects.

Left clicking

Similar to other EDA software:

e Click on an item to select it;

e |f over a selected item, click and hold to drag a selected item;

e If not over a selected item, clicking and holding while dragging creates a selection box;

e The selection box, using click and drag to the right, selects everything inside the box;

e The selection box, using click and drag to the left, selects everything inside and
intersected by the box;

e Double click on a text area to edit the text;

e The exact left click functionality depends on what item is being selected and in what
Canvas the item exists (Schematic or PCB).

momm



Right clicking
In EasyEDA, right-clicking opens a context sensitive menu:

e When you are placing a symbol, right-clicking will stop placing and return to select mode.
This is the same as the ESC key.

e When you are drawing a shape such as a polyline, after a right click, the polyline will be
stopped at the place where you right click but the mouse will remain as a cross, so you
can draw another shape.

e To get out of the current active context sensitive command such as placement or drawing
mode and go back to select mode, just double right click or press ESC (sometimes twice).

Right-Click and drag Right-clicking and holding the button anywhere in the Schematic,
Waveform or PCB Canvas while dragging the mouse will move the canvas around within the
EasyEDA window. Holding the middle button and dragging performs the same operation.

ESC key

Pressing the Esc key ends the current drawing action but does not exit the current active
context sensitive command mode (i.e. it does not return the cursor to select mode). Pressing
ESC again returns to select mode.

Select more shapes

e CTRL+Left Clicking on items adds those items to your selection;

e Clicking and holding creates a selection box;

e Creating a selection box, using click and drag to the right, selects everything inside the
box;

e Creating a selection box, using click and drag to the left, selects everything inside and
intersected by the box;

Zoom in and Zoom out

e Using the middle mouse button:

e Roll forward to zoom in;

e Roll back to zoom out;

e Using hotkeys, the default hotkey A for zoom in, z for zoom out.

Please note:

Do not scroll your mouse at the same time as pressing the CTRL key when your cursor on the
top menu, the browsers will zoom the whole website, if you just want to zoom the canvas in
the EasyEDA window, you need to put your cursor onto the canvas. If the “zoom the whole
website” happens, just press ctri+0 to reset the browser view zoom.

Double clicks

Double clicking any text area opens a resizable text box that allows you to edit the text.



Right clicking
In EasyEDA, right-clicking opens a context sensitive menu:

e When you are placing a symbol, right-clicking will stop placing and return to select mode.
This is the same as the ESC key.

e When you are drawing a shape such as a polyline, after a right click, the polyline will be
stopped at the place where you right click but the mouse will remain as a cross, so you
can draw another shape.

e To get out of the current active context sensitive command such as placement or drawing
mode and go back to select mode, just double right click or press ESC (sometimes twice).

Right-Click and drag Right-clicking and holding the button anywhere in the Schematic,
Waveform or PCB Canvas while dragging the mouse will move the canvas around within the
EasyEDA window. Holding the middle button and dragging performs the same operation.

ESC key

Pressing the Esc key ends the current drawing action but does not exit the current active
context sensitive command mode (i.e. it does not return the cursor to select mode). Pressing
ESC again returns to select mode.

Select more shapes

e CTRL+Left Clicking on items adds those items to your selection;

e Clicking and holding creates a selection box;

e Creating a selection box, using click and drag to the right, selects everything inside the
box;

e Creating a selection box, using click and drag to the left, selects everything inside and
intersected by the box;

Zoom in and Zoom out

e Using the middle mouse button:

e Roll forward to zoom in;

e Roll back to zoom out;

e Using hotkeys, the default hotkey A for zoom in, z for zoom out.

Please note:

Do not scroll your mouse at the same time as pressing the CTRL key when your cursor on the
top menu, the browsers will zoom the whole website, if you just want to zoom the canvas in
the EasyEDA window, you need to put your cursor onto the canvas. If the “zoom the whole
website” happens, just press ctri+0 to reset the browser view zoom.

Double clicks

Double clicking any text area opens a resizable text box that allows you to edit the text.



Press the enter key to save your changes. Click outside the box or press ESC to discard your
changes.

Pan/Move Canvas

e Right click anywhere in the Schematic, WaveForm or PCB Canvas and Hold down right
button to drags the canvas around within the EasyEDA window.

e |f your canvas is bigger than the EasyEDA window and is showing scroll bars, you can use
either the scroll bars or the Arrow keys to scroll the canvas to pan.

e When drawing a wire, a graphic line or shape that you wish to extend beyond the edge of
the EasyEDA window holding down the left mouse button after starting the line will pan
the canvas to keep the drawn item inside the window.

Tip:

If you use Chrome, and cursor is in the canvas while pressing CTRL or ALT key and rolling your
mouse, the canvas will move vertically, and when pressing SHIFT and rolling your mouse, the
canvas will move horizontally.

Rotate

After selecting one or more items, you can rotate the selected items using:

Top Menu > Format > Rotate or by pressing the default rotate hotkey: ‘Space’ .
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Place Format

Wiew
Rotate Left
Rotate Right

Flip Horizontal

2]

Design

Flip Vertical

= Al

Align Horizontal Centers
Align Vertical Centers

Align Grid
Distribute
Distribute
Distribute
Distribute

Horizontally

Vertically

Distribute Array. ..

Bring to Front

Send to Back

Route Tools

X

y
Ctrl+Shift+L
Ctrl+Shift+F.
Ctrl+Shift+0
CtrHShift+B
Shift+Ali+H
Shift+Alt+E
Ctri+Shift+G
Ctrl+Shift+H
Cirl+Shift+E

Left Edges Equidistantly
Top Edges Equidistantly

Advanced

Fabrication

When in PCB view mode you can click the footprint and change its rotation in the right

property panel.

Please note:

Rotating a multiple selection rotates each item about its own symbol origin. It does not rotate
the items about the centroid of the group of items.

Flip

To place a Q2 as shown in the schematic below you need to Flip the item. Via: Top menu -

Format - Flip.

Q1

Q2

2DC2412R 2DC2412R

|

You can Flip one or more selected items using:

Rotate and Flip > Flip Horizontal or Flip Vertical from the toolbar,

or by pressing the default flip hotkeys: x to Flip Horizontal, v to Flip Vertical.

Notice: Footprint does not support the flip command.

Align



EasyEDA provides many align option features, you can align your symbols or footprints very
easily using: Top menu - Format - Align. There are also icons on the toolbar for this.
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Bring to Front and Send to Back

In the image below, both the rectangle and the ellipse are filled. Use: Top menu - Format -
Bring/Send to Front/Back.

If you draw an ellipse before drawing a rectangle, the rectangle will overlap and therefore hide
the ellipse. To reveal the ellipse, select the rectangle and then use the Bring and Send
function, as shown:



Ellipse at the top

Ellipse at the bottom

Multiple Windows

Since v6.4.0, EasyEDA supports multiple windows design.
How do it works?

1. Open schematic and PCB
2. Right-click the schematic or PCB tab, click "Open in New Window"

T

Close Tab
Close Other Tabs
Close &All Tabs

-Flash.. | = PCB

3. This will open the document in a new window, then you can do the cross probe: Click the
component, pads, click the Design Manager list, the "Cross Probe and Place" also works.

Documents Tab Switch

It is easy to modify the tab positions of your documents.

Simply drag the tab location, or use the hotkeys SHIFT+1 and SHIFT+2

amat  WView Design  Tools  Fabrication  Advanced

start % *NEW_PC 17 555 Timer - Flash x
-100

100 200




Schematic Capture

Canvas Setting

During this tutorial we will create a simple Schematic design to guide you in using EasyEDA
Schematic capture.

You can find the canvas Properties setting by clicking on any the blank space in the canvas.

Attributes Selected Objects 0
“ 00 <
. Canvas Attributes
Canvas Attributes
Background #FFFFFF
Background ‘ #FFFFFF Visible Grid Yes v
Visible Grid Yes ¥ Grid Color #CCCCCC
Grid Color #CCCCCC Grid Style line v
Grid Size 5
Grid Style line v
Snap Yes v
Grid Size 5 Snap Size 5
Snap Yes v Alt Snap 5

As described earlier, background and grid colours and the style, size, visibility and snap
attributes of the grid can all be configured.

The canvas area can be set directly by the Width and Height or by using the available preset
frame sizes.

Grid:

e Visible Grid : Yes or No

e Grid Color: Any valid colour

e Grid Style: Line or Dot

e Grid Size: To ensure proper alignment of all EasyEDA parts, it is advisable to set in 10, 20,
100. the unit is pixel.

e Grid (and background) colour can be set directly by entering the hexadecimal value of
the colour you want or by clicking on a colour in the palette that opens when you click on
the colour value box:



Selected Objects 0

L Canvas Attributes

FH Background #FFFFFF
Visible Grid Yes v
Grid Color |#cccccc J

=

G

Mouse-Y 325
B Mouse-Dx 47
Mouse-DY T

Snap:

e Snap: Yes or No. Pressing this key toggles switching snap to grid on and off.
e Snap Size: To ensure proper alignment of all EasyEDA parts, it is advisable to set in 10,
20, 100 but any valid number can work, such as 1, 5, 10.

It is strongly recommended that you keep Snap = Yes all the time. Once items are placed off-
grid it can be very difficult to reset them back onto the grid. Off-grid placement can result in
wires looking as though they are joined when in fact they are not and so causing netlisting
errors that can be hard to track down.

If you need to draw detailed parts of new symbols or footprints that need to go between grid
points, try to reduce the grid spacing to draw these elements and then reset the grid back to
your chosen default value as soon as you have completed that part of the drawing. Setting
Snap=No should only really be used as a last resort.

e ALT Sanp: Snap size when pressing the ALT key.

Wiring Tools

If you have hidden your tools , you can open them from here:
Top toolbar Top Meun > View > Wiring Tools...
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Note: A/l of the commands in Wiring Tools are electronics related. Don't use a wire when you
Just need to draw a line, shape or an arrow: use Drawing Tools instead.

Wire

There are three ways to enter the wire mode in EasyEDA.

Wiring Tools _

L ENME=TD T

T A ol

il

1. Click the Wire button from the Wiring Tools palette.

2. Press the w hotkey.

3. Click on the end of a component pin (where the grey pin dot appears if you select the
component):
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EasyEDA automatically enters Wire mode.

Here is a screenshot of the Astable Multivibrator LED project schematic after wiring:
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Moving Components and Wires:

If you place a component, such as a resistor, on top of a wire then the wire breaks and
reconnects to the ends of the component.

When moving selected components using the mouse, they will drag attached wires with them
( "rubber band” ) to some extent but please be aware that the rubber banding feature has
some limitations. When moving selected components most wire will move vertically and
horizontally. Using the arrow keys will not rubber band. Selected wires do not rubber band.
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A selected wire can be moved directly by clicking on it using the mouse or by the arrow keys.
If a wire is selected by clicking on it using the mouse then green grab handles will appear at
the ends and vertices.

Auto adjust connection

If you put a resistor or capacitor on a wire, the wire will auto connect the pins as below:

R? | R2

1k | 1k
__________________ A ANAA

VsV

When you want to wiring a series of resistors which are in a row, you can just wire through
them, and then you will find they all be connected.

R1 R2 R3 R4 RS
1k 1k 1k 1k 1k
A_NAA AAA AAA AAA ANAA
VvV VAR VAR VAR VvV
R1 R2 R3 R4 RS
1k 1k 1k 1k 1k

Wire Node

When you click on the wire, you can see the nodes on the wire, where the white is the virtual
node, the red is the real node, drag the virtual node to generate the real node, and right-
delete the line segment is to delete the line segment between the real nodes.
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‘Ilqka \virtu al node
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Bus

When you design a professional schematic, perhaps it will use a lot of wires. If you wiring one
by one, much time would be wasted, and then you need to use Bus.

Wiring Tools - Selected Objects 1

_u_m—t:\m??DEE?E—L Bus

+5V w” ; o%: Stroke Color #002800
e—i1

Stroke Width 2 W
Stroke Style solid w
Fill Color none

Locked No (v

Mouse-X 735




